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Install Image-Pro Premier 
To install Image-Pro Premier, insert the product DVD and follow the instructions. 
Note that Image-Pro Premier and Image-Pro Premier 3D will not install on 
operating systems or versions of Windows older than Windows 7 (service pack 1). 

Image-Pro Premier requires the Microsoft *.NET framework. If this is not installed 
on your computer, the application will install it automatically. 

 

Upgrading the Installed Software 
There are several ways that you can upgrade the software installed on your 
computer to the latest Image-Pro Premier: 

• You may download the Image-Pro Premier evaluation software and 
install it from the Media Cybernetics’ website. 

• If you have ordered an upgrade from Image-Pro Plus 9.0 or Image-Pro 
Premier 9.1, you will receive a DVD that will install the software. 

Regardless of how you obtain the Image-Pro Premier installer, and regardless of 
which product and version you are upgrading from, the new Premier can be 
installed alongside your other software. This allows you to evaluate your new 
Image-Pro Premier for your purposes. When you are done with the older 
software and completely migrated to the latest Image-Pro Premier, then you 
can uninstall the older software from the Control Panel. 

 
 

 Please make sure that you have closed all other applications before 
installing Image-Pro Premier. 
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Upgrading your Image-Pro Premier 9.1 License 
If you are upgrading from Image-Pro Premier 9.1, you will also need to upgrade 
your license to authorize the new version. When you purchased your upgrade, 
you received an unlocking code; you will need to have this unlocking code handy 
during the upgrade process. 

There are several ways of starting the process of upgrading your license: 

• In the Image-Pro Premier Start menu folder, open the Licensing 
folder, and click Licensing Wizard 

• In the Image-Pro Premier software, open the Help menu by 
clicking the down arrow next to the Help icon, and click Licensing 
Wizard. 

Image-Pro Premier includes a Licensing Wizard to step you through the process 
of upgrading your Image-Pro Premier 9.1 license. Note that after the upgrade, 
the new license will still allow you to run previous versions of Image-Pro Premier. 

When you invoke the Licensing Wizard, you should see the following the first 
page of the wizard: 

 

 
1. Click Next to continue or Cancel to stay with version 9.1. 
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The next screen asks you to enter your unlocking code: 
 

 
 

2. Enter the unlocking code that you received with your Image-Pro Premier 
upgrade order. 

 
3. Click Next to continue. The upgrade process will begin without further user 

input. 

You will see an Upgrade Complete message when the process finishes. 

You may be asked to restart your computer. 

Register Your Image-Pro Premier License 
Image-Pro Premier requires either a hard license on a USB key or a soft license 
obtained on line. Both types of licenses must be registered. 

Register your Image-Pro Premier license to be eligible to receive special support 
service, including: 

• 90 days of free technical support 
• Automatic software updates 

USB license holders must register their licenses after installing the software and 
plugging in the hardware key. If Internet access is not available, please follow the 
instructions below for PCs without Internet access. 
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If you have an Image-Pro Premier soft license (installed on your machine) your 
license will be registered automatically when you activate your license. See the 
Activation instructions below. 

 

Activate your Image-Pro Premier License 
If you purchased an Image-Pro Premier USB license, your software will arrive 
already licensed. Plug in your USB license to start using Image-Pro Premier. Be 
sure to register your license as mentioned above so you can receive 90 days of 
support and online updates. 

If you purchased an Image-Pro Premier soft license (to be installed on your 
machine), before you can use Image-Pro Premier, a valid license file must be 
obtained from the Media Cybernetics Web site. A 14-day trial license is included 
for evaluation purposes. 

 
If your PC has Internet access and a software license 

When you first start Image-Pro Premier, you will see the following dialog: 
 

 
1. Click Activate Now to activate your license. This will load the activation web 

page in the built-in web browser. 

2. Enter the Unlocking Code that was sent with the product, together with 
standard registration information. Once your information is received, the 
license file will be installed on your machine automatically. 
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If your PC does not have Internet access 

If you choose Activate Now, and your PC is not connected to the internet, you 
will see Step 1 of the Activation process. 

 

 
1. Select a path to a removable medium, such as a USB flash memory drive. 

The software will save your files to this location along with an Activation 
shortcut link. 

2. Click OK. 

3. Take your USB key and your Unlocking Code to a machine with Internet 
access. Once you attach your USB key to the computer, the Activation Tool 
should start automatically. You will see Step 2 of the activation process. 

4. Fill in the information requested in the Product Registration page and press 
Submit. 
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5. You should see a screen indicating that the activation is successful. 

6. Return to your off-line PC to continue the activation process. Once you plug 
in the USB key, you should see a popup stating that Image-Pro Premier has 
successfully activated. 

7. Click OK. You should now be able to use Image-Pro Premier. 
 

Workspace Quick Tips 
 

File Button – Open, Print & Save 

 The File Button in the top left corner contains commands that 
operate on the document as a whole, such as Open, Print, and Save. 
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Switch from Docked to Multiple Document Interface (MDI) Layout 

You can switch between the default docked image mode and the 
traditional MDI mode easily. 
These tools are available in the View tab as well as in the Quick 
Access Toolbar. 

 
 
 

Quick Access Toolbar 
 

 
The Quick Access Toolbar is a convenient location at the top of your application 
window, where you can put shortcuts to commonly used commands. To add new 
commands, click the arrow to the right of the toolbar. 

Options Buttons 

Image-Pro Premier includes Options buttons throughout the 
workspace. Click on these gear buttons to adjust colors, font sizes, 
and other feature settings. 

 
 

Hide Dialogs for Extra Space 
 
 

Open up your workspace by hiding open dialog 
boxes. Simply click the thumbtack button on the 

top of each dialog to “hide” it to the left or right side of the application. Hover 
over the dialog to view and click the thumbtack again to display the dialog. 

 

Capture Images 
To view and capture images from your digital camera, you will first need to install 
the correct capture interface and drivers for your particular camera model. Visit   
http://support.mediacy.com to download Media Cybernetics’ capture interface 
files. Image-Pro Premier Offline users will not see Capture options. 

http://support.mediacy.com/
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Capture Single Frame Images 
 

 

1. Go to the Camera group on the Capture ribbon: 

2. Click the Live drop-down arrow and select your camera from the drop- 
down list. 

3. Click the Live button to see a live preview of your image. 

4. Click Capture to capture the image to the Image-Pro Premier workspace 
 

Capture Multi-Frame Movies 

1. Follow steps 1-3 above. 
2. Click Record to capture the movie. 
3. To Stream to Disk, open the Capture Control dialog and activate 

Stream to Disk in the Record Movie Options panel, or click the Record 
drop-down arrow. This option will remain activated until you uncheck 
the 
Stream to Disk option. 

 
 

Adjust Capture Settings 
 

 
Click the Camera Control button in the Cameras group to open the Camera 
Control dialog and adjust controls including as binning, movie options, bit-depth, 
gain, file naming, date/time stamp and file saving options. 
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Adjust, Select & Review Images 
Three Quick Ways to Zoom Images 

 
• Zoom with your mouse wheel. 

 
• Zoom with the drop down and slide bar in the right corner of the application 

window. 
2 010- 09- 20 17: 50: 56. 000 

• Click the Zoom button on the Image menu. 
 

Define a Region of Interest (ROI) 

1. Go to the ROI group on the Select ribbon. 

2. Click on the ROI tool you want to use, and draw the ROI in the image. 

3. If you want to define more than one ROI in a single image, you can use the 
Allow Multiple Regions tool. 

 

 
 

Save and Convert Overlays with the Features Manager 

Easily save regions of interest, measurements, annotations and other 
overlays using the Features Manager tool. 

1. Draw a measurement or region of interest. 

Tip: Your most recent capture settings are saved automatically at 
the end of your session. You can use the Load and Save settings to 
switch between alternate configurations quickly and easily. 
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2. Go to the Select ribbon and choose the Features Manager button. The 
Features Manager dialog will open to the right. 

3. Choose to add your measurement or region of interest to a new collection. 
4. Choose the Save button to save this collection. 
5. To convert the overlay, select the dropdown option next to the collection 

type (ex: Measurements, ROIs, etc.) and change the type. Select the Set 
Feature Collection to Image button to apply this change. 

 

 
 

Measure and Quantify 
Calibrate 
Use the Calibration group in the Capture ribbon to create and save calibrations. 

 

 
Click the Create drop-down arrow to use these calibration options: 

 
 

Clicking the Quick Calibration button creates a calibration by drawing a 
reference line on your image. 

 
Clicking the Auto Calibration button creates a calibration using the image 

of a stage micrometer. 

Count and Classify Objects 

Automatically segment, count and classify objects. 

1. Go to the Count/Size ribbon. 



Image-Pro Premier Quick Start Guide 

12 

 

 

 

 
 

2. For monochrome images, choose Bright or Dark from the Segment Group to 
automatically segment objects with bright or dark intensity levels. 

3. Choose Count to measure the objects. 

4. Choose Split to separate touching objects. 

5. Select the Excel button in the data table to export your measurements. 

Smart Segmentation 

Use Smart Segmentation to segment images with colored objects, uneven 
backgrounds, and textures. To start, go to the Count/Size ribbon. 

1. Choose Smart in the Segment Group. The Smart Segmentation dialog will 
open to the right. You must draw a reference object and then define your 
background to start segmenting. 

2. Click on the Select Objects tool to activate the 
object selection tool. Draw a circle on the 
object you wish to segment. 

3. Click on the Background tool to activate the 
background selection tool. Draw on the 
background area to activate the 
segmentation. 

4. You can continue to add objects or background to perfect the segmentation. 
5. Select Count to measure your objects. 

 

 

Tip: To select measurements, choose the Types button in the 
Count/Size or Measure ribbon to open the measurement selection 
tool. All available measurements are displayed on the left. Double 
click on a measurement to add it to your list on the right. 
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Automate Your Work 
 

Easily Record Tasks with Macros 

Automate repetitive tasks with Macro Recording tools. 

 
1. Go to the Macros group on the Automate ribbon. 
2. Choose the Record Macro button. 
3. Give your macro a name and walk through your tasks. 
4. Hit the Stop Recording button. You can now walk through your macro. 

 
Download Applications and Macros from the Solutions Zone 

Download macros and applications 
created by Media Cybernetics and 
other Image-Pro Premier users. Open the 
Macro Explorer in the Automate  
ribbon and choose Search the Solutions 
Zone. 

 

Save & Report 
Quick Save Tools 

Save images in multiple formats with easy Quick Save tools. 

 
 

1. Go to the Quick Save group 
2. Choose Analysis (.TIF), Publication (.JPG). 

or Movie (.AVI). 
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Export Images with Overlays 

The Export group in the Share ribbon includes tools to export images and 
overlays. 

Use Snap to create a new image with measurement and annotation 
overlays burned in. 

Use View to save an image with overlays burned in, at your current 
magnification. This tool is ideal for publishing a feature of interest, 
rather than the entire image. 

 
 

Create Reports 
Image-Pro Premier includes default report templates for creating reports in 
Adobe® PDF, Microsoft Excel®, and Microsoft Word®. 

1. Go to the Report group on the Share tab. 
 

 

2. Use the Images drop-down to choose your image(s). 

3. Use the Template drop-down to select your report template. 

4. Use Edit Report or Edit Template to make changes to the content and 
layout of your report, 

5. Click Preview Report to preview your report. 

6. From the Report Ribbon, click Save As to save as PDF or other file 
format. 
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Image-Pro Premier Support & Training Tools 
Video Tutorials 

Access educational video tutorials designed to teach you how to use Image-Pro 
Premier. View the videos in your Image-Pro Premier Welcome Screen and visit  
www.mediacy.com for additional tutorials. 

 
In Product Help and PDF Users Guide 

Click on the “?” button in the top right of your application to access the In- 
Product Help files. Select F1 while hovering over a button to open the related 
help files. The “?” button also includes a link to the Image-Pro Premier Users 
Guide PDF. 

Download Macros and Applications from the Solutions Zone 

Download and share applications and macros specific to your workflow from the 
Media Cybernetics Solutions Zone website. Visit www.mediacy.com 

Media Cybernetics Technical Support 

Visit our Support Site or contact our Technical Support Team if you have specific 
questions about supported drivers, software installation or other technical needs. 
Visit http://support.mediacy.com 

Media Cybernetics 
(301) 495-3305 | FAX (301) 495-5964 
www.mediacy.com 

http://www.mediacy.com/
http://www.mediacy.com/
http://support.mediacy.com/
http://www.mediacy.com/


Image-Pro Premier Quick Start Guide 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

16 

 

 


	Upgrading the Installed Software
	Please make sure that you have closed all other applications before installing Image-Pro Premier.

	Register Your Image-Pro Premier License
	Activate your Image-Pro Premier License
	If your PC has Internet access and a software license
	If your PC does not have Internet access
	Submit.

	Workspace Quick Tips
	File Button – Open, Print & Save
	Switch from Docked to Multiple Document Interface (MDI) Layout
	Quick Access Toolbar
	Options Buttons
	Hide Dialogs for Extra Space

	Capture Images
	Capture Single Frame Images
	Capture Multi-Frame Movies
	Adjust Capture Settings
	Three Quick Ways to Zoom Images
	Define a Region of Interest (ROI)
	Save and Convert Overlays with the Features Manager

	Measure and Quantify
	Calibrate
	Count and Classify Objects
	Smart Segmentation

	Automate Your Work
	Easily Record Tasks with Macros
	Download Applications and Macros from the Solutions Zone

	Save & Report
	Quick Save Tools
	Export Images with Overlays

	Create Reports
	Image-Pro Premier Support & Training Tools
	Video Tutorials
	In Product Help and PDF Users Guide
	Download Macros and Applications from the Solutions Zone
	Media Cybernetics Technical Support
	Media Cybernetics


